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1.     Overview 
 

1.1. The concept of Planning, Budgeting and Forecasting module 
 

Standard features of Kyubit Business Intelligence software offer numerous ways to analyze and visualize existing 

data from the provided data sources (OLAP, SQL, CSV). However, when looking at the values on reports, analyses, 

and dashboards, it will take some time and brain processing to decide if the values we see are successful or not, 

and still many times we will not be sure about it. The idea of the Planning, Budgeting & Forecasting module is to 

bring a completely new application section in which users on the company/organization level will prepare a Plan 

that includes existing dimensions and measures (existing OLAP data source) and plan values that are expected in 

the coming period. If an organization can prepare such a plan that relies on an existing data source, then we can 

monitor the success of the actual values in the given time period, and not only the success of the plan as a whole 

but success of individual items related to dimensions that were included in the plan monitored in various 

combinations. In other words, the Planning, Budgeting & Forecasting module makes it possible to collect plan 

values in the organization and monitor planned versus actual values in various contexts. 

 

1.2. To who it is intended 
 

Any organization that would like to monitor important business values through time will benefit by using the 

Planning, Budgeting & Forecasting module as it represents a meaningful and structured way to collect plan input 

values, offers much planning related convenient features, keeps track and history of every action and value 

provided by the plan participants, provides many ways on how to visualize the parts of the plan that are related 

to the particular interest of the user observing the plan. Especially, if the business plan has many items to plan 

over by many participants, Kyubit Planning, Budgeting & Forecasting will bring an easy-to-comprehend workflow 

and user interface for providing plan values and later dashboard visualizations of the plan in various contexts 

versus actual values. Typical usage is the sales-based organizations that need to plan various sales aspects for 

the next year (or another period of time), but it will also quickly find utilization in production, tourism, 

healthcare institutions, and other sectors. 

 

1.3. Technical prerequisites 
 

Kyubit Planning, Budgeting & Forecasting is a built-in module into the standard Kyubit BI web application that is 

separately licensed from the standard Kyubit BI features. All users are using their web browsers to interact with 

the application. The Planning, Budgeting & Forecasting module expects the existing OLAP database 

(multidimensional or tabular) that will be the base for the Plan creation and monitoring. 

 

1.4. Plan users and licensing 
 

All Kyubit users that should be involved in the planning process (Plan owners or participants) must have enabled 

planning usage in the Administration > Users section. The number of users that could be enabled for planning 

features is related to the Planning, Budgeting & Forecasting license obtained. Users who only need to see the 

plan vs actual results monitoring on the dashboards do not have to be enabled for planning usage and are not 

related to the Planning, Budgeting & Forecasting license. 
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2. Preparing a Plan 
 

2.1. Creating a new plan 
 

All users with enabled plan features could create a new plan. The plan could stay a personal plan or it could 

become available for other users within the organization. Navigate to the Planning section of the application and 

click on the New button to start creating a new plan. 

 

 

 

New plan details will be opened in a separate browser tab with the display of ‘No plan data’ text. Using the 

Manage option in the upper-right corner the plan owner leads the process of preparing initial plan details, data 

source configuration, selecting participants (if required), process of plan values input and plan finalization. 
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2.2. Plan Generals 
 

The first step is to provide very basic plan details, such as Plan Name, Plan Description, Format Values, Plan 

Success Definition, and Plan Success Tolerance.  

The Format Values input presents the numeric formatting of the plan values to ensure that plan values are 

always correctly displayed in all situations and environments (for example, the format “€#,#.##” defines that 

values are related to Euro currency and that is using thousands separator and two decimal digits). 

Plan Success Definition defines if it is more successful that plan has higher or lower values. This is only important 

while presenting the Plan vs Actual values on the dashboard charts. (for example, if we plan sales values the 

success is to have higher values than planned, while if planning expenses, then it is more successful to have 

lower values than planned). 

Plan Success Tolerance defines what difference from the plan values will be considered as a ‘partial success’ 

while presenting Plan vs Actual values on the dashboard chart. The ‘partial success’ is marked with the yellow 

circle KPI icon on the dashboard. 

All these values could also be edited anytime later during the plan lifecycle in the application (until the plan is 

archived). 
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2.3. Plan Data Configuration 
 

As the plan closely relies upon existing data to provide the status of the Plan vs Actual values, it is required to 

define data source details about from which database the actual values will be retrieved to compare with the 

plan values. At the moment, only OLAP database is supported as a data source. After providing the Plan 

Generals the next step is to choose Plan Data Configuration from the Manage menu. 

In the sample scenario for this user documentation, we will create a plan for bicycle and related products online 

sales for the next year. The best way to explain Plan Data Configuration is to first visualize the values structure 

for the plan we are about to prepare. Imagine for a moment that year 2023 is already at the end and these 

would be the actual values related to our plan. 

 

 

 

Following the structure of the Actual values, we would like to create a plan for, we will define the required Plan 

Data Configuration details.  Firstly, we will choose the appropriate OLAP database cube for Data Source where 

all actual values for our plan exist. (In this sample this is AdventureWorks sample OLAP database) 

For the Measure, we will select the Internet Sales Amount measure from the OLAP database. 

For the Plan Primary Dimension, we will select a level Subcategory from the Product dimension. Plan Primary 

Dimension defined the primary concern of our planning. In this case, these are bicycle-related products. 

 

 

 

 

 

http://www.kyubit.com/


Planning, Budgeting & Forecasting 
© 2023 www.kyubit.com, All rights reserved.  

 

 

 

 

 

 

 

Plan Periods Time Dimension defines time items over which we will prepare a plan. It could be any time 

structure. Mostly this is referred to months, quarters, or days. In this case, we will select the Month level from 

the Date dimension. 

Plan Scope Time Dimension defines the dimension level that will be used to define time scope. In this case, we 

plan for the next year, so we need to select a dimension level that holds years. We will select the Calendar Year 

level from the Date dimension. 

Plan Scope Value defines the particular value from the previous selection that is related to our plan. In this case, 

this is the year 2023. So, we will select CY 2023. 

Optionally, the plan can include the third Context Dimension. In this case, we not only plan product sales in time 

but also would like to include the sales geography dimension in the plan, we will include the Country level from 

the Customer dimensions. If we want to include other users to be participants in the current plan Context 

Dimension members will be used to assign user participation (explained in the next chapter). 

The above inputs define the relation of the plan values to the actual values. Once these details are provided the 

plan is set for the next planning steps. Anytime you click the Save button plan data configuration will be saved, 

while when you click on the Plan Data Configuration Ready, the values will be saved and set the plan for the 

next step the Participants Selection. 
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2.4. Plan Participants 
 

The next step is the Participants Selection from the plan Manage Menu. 

 

 

In any case, it is possible to continue with the plan without participants. In that case, the plan owner will provide 

all plan values. However, if the plan includes the Context Dimension it is possible to select plan participants users 

which are assigned per each of the Context Dimension items and will provide plan values for each Context 

Dimension item. In our sample plan, the Context Dimension is set to Countries, so we could assign participants 

per country. If the plan includes participants, the participants selection step cannot be completed until all 

Context Dimension items have been assigned to a participant. The single participant could be assigned to 

multiple items. When plan participants are selected, the plan values cannot be completed until all participant 

provide their inputs. If required the plan owner could change the plan participants during the planning values. 

Plan participants could be all users of the Kyubit application that have enabled Planning, Budgeting & 

Forecasting usage. 
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2.5. Providing Plan Values 
 

Up till now, we have been defining our plan data source relation and participants. Now, the plan is ready to 

accept plan values. 

 

 

The application section Plan Values presents a special place in the application with many handy features making 

it easy for the users to provide plan values. Planning values could include a large number of cells to be 

populated and special attention is given so the users could provide plan values with the least effort. Opening the 

Plan Values will display the full-screen grid with a cell ready to accept plan input values. The grid is designed to 

mimic the Excel look and feel while editing cells. The grid is organized so the first row and column present 

aggregated values. Primary dimension items are displayed vertically, while time items are displayed horizontally. 
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2.5.1. Context Dimension 
 

If the plan includes the Context Dimension it will be displayed as the drop-down selection on the top. If the plan 

has participants, only the participants can provide the values for the items assigned to them. Assigned items for 

the current user are marked with bold text. In that case, select the bolded option to provide the plan values. If 

the current user is the plan owner, he can see all Context Dimension items, but he can provide the values only 

for items assigned to him. 

 

 

 

 

2.5.2. Navigate, edit, update and discard 
 

Navigate with arrow keys or a mouse click to the cell you want to provide plan value in the grid. Edited cells will 

change the background color. Edited cell values are not automatically saved. When you want to save and apply 

provided values, click on the Update button above the grid. After cell values are updated on the server, they will 

change the background color to white. Anytime click on the Discard button to discard current input and revert 

back to the last saved values state. 
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2.5.3. Use Excel-like editing features 
 

The Plan values grid will behave similarly to the Excel grid. Click and hold the cell handle and drag horizontally or 

vertically to fill other cells with the same value.  

 

                         

 

Select a horizontal or vertical range of cells, and press CTRL+C and CTRL+V to copy/paste the cell range to other 

cells on another part of the grid. Or press Del on the keyboard to delete cell range values. 

 

 

 

Bib-Short values copied to Bike Stands... 
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2.5.4. Views on Previous values, Plan values and Actuals values 
 

A very convenient and handy feature is to display values from the past (or present) while planning values for the 

future. In the upper right corner of the planning grid, there are options to toggle the display or Previous, Plan, 

and Actual values. In this sample, we plan the sales for the year 2023. While planning for this year it is often 

useful to see what were actual values in 2022 for the same items. Just click on the Previous button to toggle the 

display of past actual values. Later in the year 2023, you can also toggle the Actual button to display the actual 

values that happened for our plan and compare vs planned. 

 

 

In the sample plan, we can see actual values for Mountain Bikes and Road Bikes in January 2022, so we could 

better plan for January 2023 for the same items. 

 

 

 

Later in the year 2023 when our data source has actual values from the 2023 year, we can also toggle the 

Actuals button to see how individual cell with planned value compares to the actual. In the picture below, we 

can see for the Mountain Bikes and Road Bikes plan items what was a) the actual value in January 2022, b) the 

planned value for January 2023, and c) the actual value in January 2023. 

 

 

 

Note that the Previous and Actual values are marked with different colors (orange and green), so they could be 

easily distinguished from the main planned (blue) values. (Normally, while planning the values, actual values still 

do not exist. Here the actuals are included to give full information on what could be displayed along with the 

planned values in the plan usage lifecycle.) 
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2.5.5. Copying values from the past with one click 
 

It is possible to copy all values from the past to the current plan view with one click. In the Options on the 

upper-right select one of the options from the menu that will do 1) copying of all values, 2) only for empty cells 

in the current plan view or 3) for the cell range that is currently marked in the planning grid. 

 

 

 

2.5.6. Narrow the display of plan items by selecting appropriate hierarchy members 
 

In case there are a lot of items (Primary planning dimension) to prepare a plan value and the current user is 

interested only in some of them to prepare the plan for, the plan items display could be narrowed to 

appropriate items if the Primary planning dimension is based on the hierarchy. In our sample, the Primary 

planning dimension is set to Subcategory, which is a part of the Product hierarchy (which consists of Category > 

Subcategory > Products levels). If the current user needs to prepare a plan only for Subcategory items related to 

Clothing, click on the Hierarchy button and select Clothing from the hierarchy view to display only Subcategory 

items related to Clothing. 
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2.5.7. Completing the plan values input 
 

If the plan doesn’t include the participants, then there is no need to mark the completion of the plan inputs. A 

single user (Plan owner) will provide values he decides are necessary and finalize the plan at any point of plan 

input he decides all values are provided. 

If the plan includes the participants, each participant has to click on the Marked as Completed button to mark 

his providing values for the given item completed. After the item is marked as completed, it cannot be edited 

further. (If an item is marked as completed, by mistake, the plan owner can Revert the item back to the pending 

status). 

 

 

 

 

The plan owner can see on the plan home page what plan assignments are completed by participants. Moving 

the mouse over the completed assignment, the Revert button is displayed to optionally return the assignment 

to the Pending state. 

 

 

 

If the plan includes participants when all participants mark their assignments completed, the plan owner 

receives an email from the application with the information that all participants have finished their assignments 

and the plan is ready to be finalized. 
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2.5.8. Observing the process of gathering plan values 
 

While plan values are being provided by the participants, Plan owner (and all other users with read permissions 

on the plan) can observe what values are already provided and who’s plan assignments are still pending. After 

opening the plan home page, in the upper-right corner is refresh button, that could be used to refresh current 

plan values provided. On the left-upper side the current plan status is indicated. First upper chart show plan vs 

actuals over the plan time dimension level (in this case Months). In the lower table chart, plan values are 

aggregated per Plan Primary dimension (in this case Subcategory) and also presenting difference between plan 

and actual values (if actuals exists). 

 

 

 

2.5.9. Plan History 
 

All plan actions in the plan lifecycle are registered in the plan history with action user and action time. Visible on 

the plan home page in the middle tab. 
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2.6. Plan Permissions and including plan observers 
 

Besides the plan owner and optional plan participants, it is possible to include other users to follow what is 

happening with the plan on the plan home page. To add observers add Read permission on the plan for any 

Kyubit user who will be able then to open the plan and observe plan values and other details (without the option 

to change anything). To add additional Plan owners (users with full permissions on the plan) add Read-Write 

permission on the plan for existing Kyubit users. To add plan permissions, click on Manage > Options > 

Permissions. 

 

 

 

2.7. Discarding current plan values 
 

Before the plan is finalized, the complete plan values could be discarded and the plan status will return to step 

Plan Data Source Configuration by the plan owner by selecting the option Manage > Options > Discard Plan 

Values. 
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2.8. Finalizing the plan 
 

 

 

When all required plan values are provided, the plan can be Finalized by the plan owner. Finalizing the plan 

means a couple of things. First, this plan version is final, there could be no more changes whatsoever (it is 

possible to create a new version of the plan which will be discussed in a later chapter). Second, the plan input 

values are used in the process of distributing the values a) across all time dimension hierarchy levels and b) 

across parent levels of the primary and context dimension (if exists). The plan is ready to be used on dashboards 

and monitors planned values vs actual values (described in chapter 3.) by all authorized Kyubit users (also users 

who do not use planning features). 

 

Depending on the number of members in the related dimension hierarchy levels, the plan finalization and plan 

values distribution and aggregation could take up to several minutes.  

 

 

 

 

 

 

http://www.kyubit.com/


Planning, Budgeting & Forecasting 
© 2023 www.kyubit.com, All rights reserved.  

 

 

 

2.8.1. Distributing plan input values to other dimension levels 
 

Let’s explain what means distributing plan input values and what are the benefits. Regarding the Time 

dimension, input values are distributed to all levels of the existing time dimension. For example, in our sample 

plan, plan input values are provided for each Month. Because the related hierarchy Date.Calendar consists of 

the following levels: Calendar Year, Calendar Semester, Calendar Quarter, Month, and Date. The monthly plan 

values will evenly distribute or aggregate for each member in the existing time hierarchy levels. So, while 

observing plan values on the dashboard we can present/analyze plan values for quarters, semesters, years, or a 

day in a particular month, depending on the interest (even though the values are not explicitly given for those 

time structures). The values for quarters will be the results of the month values aggregation, while values for 

days (or any other lower level of the plan level) will be populated by even distribution of the plan value for the 

given month. 

 

 

 

For the Primary and Context plan dimension plan values are aggregated on the upper levels of the hierarchy (if 

the hierarchy is used). So, the plan values are provided for the product Subcategory, while in the process of 

finalization, the values will be aggregated on the product Category level. 
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3. Using prepared Plan on the dashboard 
 

After the plan finalization, we can consider the plan as prepared for the usage to continually monitor planned vs 

actual values in the time scope defined by the plan. Besides the plan home page, plan values vs actuals could be 

monitored and analyzed on the dashboards in various ways to best match the interest of the observers. It could 

be a high-level plan success monitoring or daily insights to catch the day or hour success comparing plan vs 

actual values on particular products, cities, or any other dimension member associated with the plan. In this 

chapter, we will show some of the most interesting aspects of plan analysis and monitoring. 

 

3.1. Adding the Plan vs Actuals data to a dashboard chart 
 

Any Kyubit chart can accept Plan data to visualize it appropriately. To add Plan vs Actuals data in the dashboard 

design mode, add a chart to the dashboard surface. In the chart design > data, select the Plan tab and select the 

appropriate plan data set. Plan data is available in 3 forms, Plan Vs Actuals (as a single data set), Plan values, or 

Actual values (related to the plan). We will describe and show the usage of all 3 Plan data sets.  

 

 

 

After selecting the plan data, optionally select the Category to display plan values aggregated on any of the 

available plan dimension levels on the chart category axis. Select the Category in Chart > Design > Options tab. 

The Category could be any other plan-related dimension levels that exist after the plan finalization. 
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Here are some of the example charts based on the Plan Vs Actuals data set and our sample plan Bicycle Sales 

2023. Note that when the Plan Vs Actuals data set is selected chart series of values are always PLAN and 

ACTUAL. The Plan data set is related to provided plan values during the planning phase, while Actuals data set 

are data displayed from the related OLAP data source. 

 

Chart Category set to (product) Category plan dimension level. Even though planning values are provided on the 

(product) Subcategory, after the finalization process, values are aggregated and available for the (product) 

Category level as well… 

 

 

Chart Category set to Country plan dimension level … 
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Chart Category set to Day plan dimension level. In this line chart, we can see the plan vs actual value for each 

day in a year … 

 

 

If we do not set the chart category, we will get a single chart item with 2 series presenting plan total vs actual 

total.  
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Include the pivot option to display the complete plan total vs the actual total on the pie chart. 

 

 

 

If we create a dashboard with the above charts, it will present the success of the plan with the whole year's Plan 

Vs Actual data. However, if we set the dashboard filter to a specific dimension member related to the plan (Such 

as time member, specific country, or specific group of products or similar), all these charts will be sliced with 

such selection turning the dashboard plan view to a particular interest of the user related to the plan. In the 

below example, all charts are presenting Plan vs Actual data only for the third quarter of the year. It could be as 

well Bike group of products, a specific continent, or any other dimension member that the plan is ‘aware’ of. 
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With all available plan dimension levels, it is possible to create endless combinations of charts and filtering on 

dashboards that should cover almost every plan aspect and a business requirement that may be related to the 

whole Planning, Budgeting & Forecasting idea. 

 

3.2. Plan vs Actual on the dashboard Table chart 
 

When Plan vs Actual data is added to a Table chart there are some additional benefits. First, the table chart will 

also display delta (difference) values between plan and actual value in the form of the pure difference and 

difference percent compared to the planned value. If delta values are not wanted, remove them in the chart > 

Options > Specific Series field. 

Furthermore, the Table chart has the option to display expanded (drill-down) data by setting two chart category 

dimension levels in the chart > Options > Category field (just click twice to select an additional category 

dimension level). 

 

 

Below is an example of a table chart with the Bicycle Sales 2023 plan. Note that the table chart includes a 

success icon that is related to the Plan Success Tolerance field defined on the plan’s general data. 
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Another example of the table chart with different Plan dimension levels expanded (product) Subcategory > 

Quarter … 
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3.3 Plan Combo chart 
 

A Combo chart is a chart that compares two data sets that have the same chart category items. To visualize plan 

data on the Combo chart we will not select the Plan vs Actual data set (because we need two sets of data to 

compare and plan vs actual is a single set), but we will choose Plan data as the primary data set and Actual data 

as compare data set while choosing data for the chart in the chart > Data > Chart Data > Plans tab. 

 

 

 

The result is the combo chart with optional delta chart on the top that give nice insight into the plan vs actuals 

differences (per defined chart category, in this case months) … 
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Here is the Combo chart with cumulative differences that also answers the whole plan's success. We see that 

the plan was unsuccessful in the first part of the year, but the second part leads to the overall plan vs actual 

success. 

 

 

 

Of course, the Combo chart could compare plan values based on any other plan dimension level. In this 

example, we visualize Plan vs Actual success per country… 
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3.4. Slicing the Dashboard chart values 
 

You can always add another dashboard filter to slice further plan data, but an even better way is to enable 

dashboard auto-slicing which will slice the rest of the dashboard charts with a single click on any of the plan 

chart values. In this case, we click on the Bikes which will slice other charts and present data only related to the 

Bikes product category. 
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3.5. Plan KPIs, Goal-meters and Gauges 
 

The prepared plan is actually a huge resource from which various KPIs could be extracted. For a start, the 

complete ‘plan values vs actual values’ status is the KPI for itself. In our sample plan, it would be Internet Sales 

Amount Plan vs Internet Sales Amount Actual values. However, numerous smaller certain aspect-related KPIs 

could be quickly utilized on a plan basis. The Plan KPI would tell us the success status of the plan up-to-date 

(from the plan start to this day). It is understandable that users related to the plan are certainly interested to 

open a dashboard to quickly see the plan success status on this day (the complete plan or certain aspects of the 

plan). Here we will describe some plan KPI usage samples and some prerequisites to work with plan KPIs. 

Add the KPI chart on the dashboard and select chart > edit > Data > KPI. A list of existing KPIs will appear and at 

the end, all active plans will be listed to choose from. All active plans will be automatically listed when selecting 

the KPI source (It is not required to create a previous KPI object in the Kyubit KPI/Scorecard section). 

 

 

 

 

If you add a Plan KPI before the plan starting date you will get an empty KPI chart (N/A) as the Plan KPI is always 

looking at Actual values up to the current date. Even if you have Actuals values in the OLAP cube they will not be 

included if they are not related to the plan time scope to the current date. The plan is for the year 2023, the 

current date in this example is November 2022 and there is nothing to display related to the plan KPI. 
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Now, imagine that it is now November 2023. Since there are Plan vs Actual values that are relevant for the 

current date, the Plan KPI will render values and success status. The value displayed on the KPI is the actual 

value only up until today (including today). It is then compared with plan values until today and the success icon 

is displayed. (Note that Success and Fail thresholds are defined by the plan success tolerance value in the plan 

data.) 

 

 

You can display the same Plan KPI as a Goal Meter chart that also displays the percent of the plan success … 

 

 

 

… or a Gauge chart that visually indicates how far the plan is from the fail or success threshold… 
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3.5.1. KPI, Goal meter of Gauge for certain aspect of the plan 
 

In the previous example, the Plan KPI shows the value and status of the complete plan until today. To display the 

same for a specific aspect of the plan add a dashboard filter that is related to Plan Dimension Levels.  

In the following example, we observe the Plan KPI for Australia, which shows very successful plan status for the 

plan vs actual until today. 

 

 

 

On this example we see plan failure related to (product) Category set to Clothing and value we have until 

today… 
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3.5.2. Using standard Kyubit dashboards features with Planning, Budgeting & Forecasting 
 

For users who are not familiar with Kyubit dashboard features here are some important features that could be 

of significant benefit and used with planning and monitoring of Plan vs Actual values. Please read Kyubit 

Dashboard features user manual to see all dashboard options available and how to use them. 

 

3.5.2.1. Dashboard Subscription 

After the dashboard with Planning, Budgeting & Forecasting data is created. All users could subscribe to receive 

the same dashboard with fresh values on email at the scheduled time. 

3.5.2.2. Embedding dashboard to another HTML base page (external web application) 

The dashboard could be embedded with a simple HTML/JavaScript into another web page. 

3.5.2.3. Mobile view on the dashboard 

The dashboard could be opened in mobile-friendly view on the mobile browsers on the URL 

http://[Kyubitapp]/Mobile 

3.5.2.4. Export dashboard to PDF file 

All charts and values are exported to a PDF file. 

3.5.2.5. Display dashboard charts as slides (slideshow)  

Displays each dashboard chart in the full-screen mode for a defined amount of time. 
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4. Creating a new plan version and archiving 
 

4.1. New Plan Version 
 

Once the plan is finalized, plan values cannot be changed. If there is a conclusion that circumstances have 

changed and plan values needs revision, it is possible to create a new version of the plan (no application limits 

the number of new versions). Updating plan values for the new version will start with old/previous inputs that 

are provided in the previous planning stage (no need to enter all values from the scratch). If the plan includes 

participants, they will not all automatically get the action to update their plan values, but the plan owner needs 

to revert plan assignments for those he decides need revision. To create a new version of the finalized plan 

navigate to the plan home page > manage > options > Create new version. 

 

 

 

 

The plan will be returned to Plan Values status. After updating the plan with new values, again plan owner 

decides when to finalize the plan and which will again process all input values to distribute and aggregate over 

all plan dimension levels. Once the plan has a new version, old version plan values are still in the system and can 

be observed on the plan home page > Versions (that will appear on the right side). 
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4.2 Plan Archiving 
 

After the plan is completed (not relevant anymore) or does not have significance to be listed among other active 

plans, the plan owner can choose to archive the plan. To archive the plan navigate to the plan home page > 

manage > options > Archive plan. 

 

 

 

Archived plans can be listed with a click on the Archive plans link in the Planning section of the application. 

Archived plans will not be listed while choosing the dashboard data for the new charts. 
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5. Including processed plan values to existing Data Warehouse 

(Advanced) 
 

This chapter explains how you can include all plan values (distributed on all plan dimension levels) back into your 

existing data warehouse database, so you could a) create an OLAP cube with planned values distributed over 

related dimension levels, and b) use planned values outside the Kyubit application. All planned values are saved 

in the Kyubit SQL database KyubitAnalyticModels as the plan features are using Kyubit Analytic Model 

technology for quick multidimensional analysis. To return plan vs actual data Kyubit application in parallel is 

running MDX queries with OLAP cube to return actual values and running Analytic model analysis to return 

planned values. Two data sets are merged and presented on Kyubit charts. If you are interested to include 

planned values as an additional measure in your OLAP cube structure, so you could analyze it within Kyubit OLAP 

grid features or any other OLAP front-end solution here are some technical insights that should be of help. 

5.1. Plan values in KyubitAnalyticModels database 
 

Table Models holds data for all Analytic Models (Plan values are saved in the form of an Analytic Model). 

Discover the ModelID value related to the plan that is visible by the plan name. 

 

 

 

In our plan sample, the ModelID identifier is 3308. This means that plan values exist in the fact table Model3308. 

After opening this table, you will see all plan values distributed per all plan dimension levels. To get the full 

processed (distributed/aggregated) plan values filter with the value KYFinalized = 2. 

 

 

 

The first column presents the plan value distributed on the leaf time level (in this sample, the Date). Other 

columns refer to Plan dimension levels. All dimension levels table names start with Level{ModelID} in our sample 

this is Level3308. 
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Open the dimension table to see related dimension level details. If the dimension¸-level members in the OLAP 

cube include MemberKey, this value will be visible under the ExternalKey column in this table. Using the values 

from the model fact table and ExternalKey value from dimension tables you could create a SQL query that takes 

plan values that exactly match dimension members that exist in the OLAP cube. 

 

 

 

Diagram of plan (Analytic Model) tables relationship in the case of sample plan prepared in this document… 
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